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MODUL 1 

PEMBAHASAN TENTANG 

ADOBE PHOTOSHOP DAN COREL DRAW  

(Pratikum 1) 

 

A. ADOBE PHOTOSHOP 

1. Pengertian Adobe Photoshop 

Photoshop atau disebut Photoshop adalah perangkat 

lunak editor citra buatan Adobe Systems yang 

dikhususkan untuk pengeditan foto/gambar dan 

pembutan efek. Perangkat lunak ini banyak digunakan 

oleh fotografer digital dan perusahaan iklan sehingga dianggap sebagai 

pemimpin pasar (market leader) untuk perangkat lunak pengolah 

gambar/foto dan bersama Adobe Acrobat, dianggap sebagai produk terbaik 

yang pernah diproduksi oleh Adobe Systems.  

 

2. Kelebihan Adobe Photoshop 

a. Mudah di operasikan. 

b. Banyak sekali fitur – fitur yang unggul. 

c. Bisa di gunakan untuk membuat tulisan dengan efek yang di 

inginkan. 

d. Bisa di gunakan untuk mendesain maupun untuk editing gambar. 

e. Bisa membuat beragam material. 

f. Fasilitas untuk editing lebih lengkap di banding lainnya. 

g. Bisa untuk rekayasa foto. 

h. Bisa menambah efek lagi meski sudah terlalu banyak efek. 
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i. Penyimpanan dapat menggunakan berbagai format. Format 

penyimpanan tidak sekedar PSD, namun JPEG dan yang lainnya. 

j. Photoshop lebih cepat kerjanya. 

 

3. Kekurangan Adobe Photoshop 

a. Banyaknya layer yang di gunakan 

b. Ukuran yang di butuhkan terlalu besar.  

 

Jika ingin mempelajari tentang Adobe Photoshop bisa membaca buku 

yang ada dibawah ini : 

 

 

B. COREL DRAW 

1. Pengertian Adobe Photoshop 

Corel Draw merupakan sebuah program komputer editor 

grafik vektor yang dikembangkan oleh Corel 

Corporation, perusahaan perangkat lunak yang berbasis 

di Ottawa, Kanada. 

 

Secara umum, Corel Draw berfungsi untuk mengolah gambar dan 

banyak digunakan pada bidang publikasi, percetakan, dan bidang lain yang 

membutuhkan proses visualisasi. 

 

Buku dapat diunduh di https: 

//www.jurnalweb.com/ebookphotosh

op-gratis-untuk-belajar-edit-foto-ba 

gi-pemula/ 

 

https://www.jurnalweb.com/ebookphotoshop-gratis-untuk-belajar-edit-f
https://www.jurnalweb.com/ebookphotoshop-gratis-untuk-belajar-edit-f
https://www.jurnalweb.com/ebookphotoshop-gratis-untuk-belajar-edit-f
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Corel Draw menawarkan beragam keunggulan kepada penggunanya. 

Sebagai program yang banyak digunakan untuk proses visualisasi, Corel 

Draw dapat menghasilkan gambar dengan kualitas baik dan tidak kalah 

dengan bitmap meskipun berbasis vektor. 

 

2. Kelebihan Corel Draw 

a. Fiturnya cukup lengkap. 

b. Ampuh untuk pembuatan illustrasi, logo, dan vector image lainnya. 

c. Kemampuan yang mumpuni untuk load file besar, diatas 50Mb. 

d. Warna-warna yang disediakan sangat baik dan halus, tidak jauh 

beda dengan hasil print nantinya. 

e. Terintegrasi dengan software Adobe yang lain, seperti Adobe 

Photoshop. 

 

3. Kekurangan Corel Draw 

a. Walaupun fitur lengkap, tapi cukup ribet untuk pengerjaan layout. 

b. Tidak User friendly untuk fitur power clip-nya 

c. Tempat produksi terkadang ada yang tidak support. 

 

Jika ingin mempelajari tentang Corel Draw bisa membaca buku-buku 

yang ada dibawah ini : 

  

Buku dapat diunduh di https:// 

www.pdfdrive.com/coreldraw-gr 

aphics-suite-x6-guidebooke164 9 

4572.html 

 

http://www.pdfdrive.com/coreldraw-gr%20ap
http://www.pdfdrive.com/coreldraw-gr%20ap
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MODUL 2 

MEMBUAT ID CARD MENGGUNAKAN 

ADOBE PHOTOSHOP CS6 

(Pratikum 2) 

 

A. Langkah Kerja 

1. Buka terlebih Adobe Photoshop CS 6. Pilih File > New. 

 
 

2. Kemudian pilih milimeters, dengan Width 625, Height 1011 dan 

Resolution 300. 

 
 

 

 

 

1 

2 
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3. Maka akan tampil lembar kerja atau kanvas seperti ini. 

 
 

4. Kemudian pilih tools Elipse Tool. 

 
 

5. Kemudian tarik ke lembar kerja atau kanvas tadi. 

 

Lembar Kerja / 

Kanvas 

Hasil dari Ellipse 

Tool 

Nama  Layer 
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6. Dan buatlah, sehingga terbentuk seperti dibawah ini. 

 
 

7. Buat lah folder untuk layer Elipse Tool, agar kelihatan lebih rapi. Dengan 

cara pilih Elipse Tool dan masukkan kedalam folder yang telah dibuat tadi. 

 
 

 

 

 

 

 

 

 

 

 

 

Duplikat Layer 

Ellipse menjadi 3 

Layer. Dan ubah 

warna  

Tampilan Layer 

Ellipse 

Digunakan 

untuk 

mengkelompok

kan beberapa 

Layer menjadi 

sebuah folder 

Group. 
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8. Sehingga muncul seperti gambar dibawah ini. 

 
 

9. Kemudian copy folder tersebut. 

 
 

10. Kemudian ubah rotasi ke 180 derajat, dan tarik keatas.  

 
 

Hasil dari 

pengkelompok

kan beberapa 

Layer menjadi 

satu buah 

folder Group 

Duplikat folder 

Group  menjadi 

2 folder Group. 
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11. Setelah itu, beri teks dengan memilih tools Horizontal Type Tool. 

 
 

12. Maka akan seperti ini hasilnya. 

 
 

13. Lalu, masukkan logo Politeknik Kampar. 

 

Hasil teks yang 

dibuat 

menggunakan 

Horizontal Type 

Tool 
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14. Dan seperti ini ketika logo Politeknik Kampar dimasukkan. 

 
 

15. Kemudian pilih tools Rectangle Tool, untuk meletakkan pas foto. 

 
 

16. Seperti ini tampilan ketika dimasukkan tools Rectangle Tool. 

 

Logo 

Politeknik 

Kampar 

Untuk meletakkan 

pas foto 
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17. Lalu berikan Stroke agar pada sisi Rectangle Tool terdapat pembatas. 

Dengan cara pilih Layer > Layer Style > Stroke. 

 
 

18. Setelah itu, atur Stroke sesuai dengan Size 3. 

 
 

19. Kemudian siapkan pas foto yang akan digunakan. 

 

1 2 

3

1 
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20. Kemudian tarik pas foto ke dalam lembar kerja. 

 
 

21. Maka seperti ini ketika pas foto sudah dimasukkan.  

 
 

22. Kemudian tambahkan teks lagi. 

 
23. Kemudian pilih tools Rectangle Tool. 

Tampilan 

pas foto 

ketika sudah 

dimasukkan. 

Tambahkan teks 
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24. Kemudian bentuk seperti pada gambar. 

 
 

25. Kemudian duplikat Rectangle Tool. 

 
 

Duplikat Layer 

Rectangle Tool 

menjadi 2 Layer. 
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26. Kemudian geser sedikit Ractangle Tool yang duplikat. 

 
 

27. Kemudian siapkan gambar yang akan digunakan.  

 
 

28. Kemudian letakkan Layer gambar gedung Politeknik Kampar diatas 

Rectangle Tool. 

 

Masukkan 

gambar 
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29. Lalu klik kanan pada Layer, pilih Create Clipping Mask. 

 
 

30. Sehingga seperti ini tampilannya. 

 
 

31. Kemudian, tekan Layer Rectangle 2 copy pilih Layer > Layer Style >  

Blending Options. 

 

Hasil gambar 

setelah di Create 

Clipping Mask 

1. 1. Tekan 

terlebih 

dahulu Layer 

Rectangle 2 

copy 

2 

3 
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32. Kemudian atur Opacity untuk Layer Rectangle 2 copy. 

 
 

33. Dan seperti ini ketika Opacity Layer Rectangle 2 copy diatur. 

 
 

34. Kemudian tambah teks. 

 

Hasil setelah 

Opacity diubah 

Ubah 

menjadi 72 % 

Tambahkan teks 
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35. Kemudian siapkan gambar QR Barcode. 

 
 

36. Kemudian tarik gambar ke lembar kerja. 

 
 

37. Kemudian tambah teks. 

 

Gambar QR 

Barcode  

Tambahkan 

teks 
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38. Kemudian masukkan logo Instagram, logo Whatsapp dan logo Web 

kedalam lembar kerja. Setelah itu tambahkan teks. 

 
 

39. Kemudian simpan project dengan cara pilih File > Save As. 

 
 

40. Simpan project dengan format JPEG. 

 

Tambahkan 

logo 

Tambahkan 

teks 

1 

2 
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A. Hasil Pratikum Modul 2 

 

 
 

Gambar diatas merupakan hasil dari membuat Id Card Adobe 

Photoshop CS6. Dan pada Pratikum 2 ini saya berhasil membuat Id Card. 
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MODUL 3 

MEMBUAT NAME CARD MENGGUNAKAN 

ADOBE PHOTOSHOP CS6  

(Pratikum 3) 

 

A. Langkah Kerja 

1. Buka terlebih Adobe Photoshop CS 6. Pilih File > New. 

 
 

2. Kemudian pilih Centimeters, dengan Width 9, Height 5.5 dan 

Resolution 300. 

 
 

 

 

 

Tampilan awal Adobe 

Photoshop CS6 
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3. Maka akan muncul tampilan lembar kerja atau kanvas seperti ini. 

 
 

4. Kemudian pilih tools Rectangle Tool. Dan buat bentuk seperti dibawah 

ini. 

 
 

5. Kemudian berikan warna pada Rectangle Tool sesuai dengan warna 

keinginan. 

 

Lembar kerja / 

kanvas 

Rectangle 
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6. Dan pilih Edit > Transform Path > Distrot. 

 
 

7. Kemuidan dorong ke dalam bagian ujung Rectangle Tool, sehingga 

berbentuk seperti dibawah ini. 

 
 

8. Duplikat Rectangle Tool sebanyak dua buah, berikan warna berbeda 

pada setiap  Rectangle Tool yang di duplikat. 

2 

1 

3 

4 

Dorong 
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9. Kemudian buat lagi Rectangle Tool. 

 
 

10. Kemudian ubah warna Rectangle Tool menjadi warna hitam.  

 

Duplikat menjadi 3 

Layer Rectangle 

1 

2 

1 
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11. Setelah itu, duplikat Layer Rectangle 2, ubah warna sesuai keinginan 

dan geser keatas sedikit. 

 
 

12. Kemudian tambahkan teks menggunakan Horizontal Type Tool. 

 
 

13. Lalu, ketikkan nama dan jabatan. 
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14. Kemudian siapkan logo QR Code. 

 
 

15. Lalu tarik gambar ke lembar kerja, dan sesuaikan letak dan ukurannya. 

 
 

16. Dan siapkan juga logo untuk kartu nama. 
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17. Lalu tarik logo ke lembar kerja, dan sesuaikan letak dan ukurannya. 

 
 

18. Setelah itu, tambahkan teks dengan menggunakan Horizontal Type 

Tool. 

 
 

19. Tambahkan teks didekat logo yang telah ditambahkan. 
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20. Siapkan juga logo untuk telepon. 

 
 

21. Tarik gambar ke lembar kerja, dan sesuaikan letak, ukuran dan 

warnanya.  

 
 

22. Kemudian tambahkan teks lagi. 
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23. Dan siapkan lagi logo home. 

 
 

24. Kemudian tarik gambar ke lembar kerja, dan sesuaikan letak, ukuran 

dan warnanya. 

 
 

25. Kemudian tambahkan teks. 
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26. Dan siapkan lagi logo Facebook. 

 
 

27. Kemudian tarik gambar ke lembar kerja, dan sesuaikan letak, ukuran 

dan warnanya. 

 
 

28. Kemudian tambahkan teks. 
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29. Dan siapkan lagi logo Email. 

 
 

30. Kemudian tarik gambar ke lembar kerja, dan sesuaikan letak, ukuran 

dan warnanya. 

 
 

31. Kemudian tambahkan teks. 
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32. Kemudian bentuk sembarangan menggunakan Pen Tool. 

 
 

33. Dan ubah warnanya menjadi warna putih. 

 
 

34. Dan pilih Layer > Layer Style > Blending Options. 

 

Ubah warna 

disini 

2 3 

1 
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35. Kemudian ubah Opacity menjadi 6 %. 

 
 

B. Hasil Dan Pembahasan Modul 3 

 

 

Gambar diatas merupakan hasil dari membuat Name Card  

menggunakan Adobe Photoshop CS6. Dan pada Pratikum 3 ini saya 

berhasil membuat Name Card. 

 

  

Berubah menjadi 

transparan 
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MODUL 4 

MEMBUAT BANNER MENGGUNAKAN 

ADOBE PHOTOSHOP CS6  

(Pratikum 4) 

 

A. Langkah Kerja 

1. Buka terlebih Adobe Photoshop CS 6. Pilih File > New. 

 
 

2. Kemudian pilih milimeters, dengan Width 80, Height 180 dan 

Resolution 300. 
 

 
 

 

 

 

 

Tampilan awal Adobe 

Photoshop CS6 
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3. Maka akan tampil tampilan kertas kosong seperti ini. 

 
 

4. Kemudian pilih Rectangle Tool. 

 
 

5. Kemudian buat menggunakan Rectangle Tool untuk membuat 

desainnya. Untuk membuat bentuk segitiga klik pada Layer Rectangle 

Tool, lalu pilih Edit  > Transform > Distort. 
 

Lembar kerja / 

kanvas 
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6. Dan siapkan logo agar orang tau bahwa itu produk kita. 

 
 

7. Lalu letakkan logo pada lembar kerja, sesuaikan letak dan ukurannya. 

 
 

 

Dibuat menggunakan 

tools Rectangle Tool. 

Disesuaikan warna, 

posisi  dan ukurannya. 
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8. Setelah itu berikan teks didekat logo yang telah dimasukkan. 

 
 

9. Begini tampilan ketika di dekat logo diberikan teks.  

 
 

10. Kemudian siapkan juga icon paint berformat png. 
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11. Dan seperti ini tampilan ketika dimasukkan icon paint. 

 
 

12. Dan siapkan juga gambar frame seperti ini. 

 
 

13. Kemudian letakkan frame didekat logo yang sudah kita masukkan tadi, 

sesuaikan frame dengan logo. 

 

Frame 
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14. Kemudian berikan teks agar orang-orang tau, jika banner yang dibuat 

menyediakan jasa. 

 
 

15. Seperti ini tampilan ketika diberikan teks. 

 
 

16. Lalu pilih Rectangle Tool. 
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17. Setelah itu, buat persegi panjang seperti ini. 

 
 

18. Kemudian siapkan icon ceklis yang akan digunakan. 

 
 

19. Kemudian letakkan icon ceklis diatas Layer Rectangle. 
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20. Kemudian tambahkan teks.  

 
 

21. Lakukan secara berulang-ulang, sehingga tampilannya seperti dibawah 

ini. 
 

 
 

22. Lalu masukkan gambar sebagai contoh, dan berikan dibawah layer 

gambar Rectangle Tool agar dibagian sisi gambar seperti memiliki 

bingkai. Dan berikan teks pada bagian bawah banner.  
 

Duplikat folder 

group layer 

rectangle, 

menjadi 6 buah 

folder group. 
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23. Lalu siapkan icon Whatsapp, Instagram, Email dan Maps. 

 
 

24. Kemudian letakkan ketiga logo pada lembar kerja, sesuaikan letak dan 

ukuran. Lalu berikan teks menggunakan Horizontal Type Tool. 

 
 

Sisi pada gambar 

dibuat menggunakan 

Tools Rectangle Tool 

Tambahkan 

logo 

Tambahkan teks 
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25. Kemudian tambahkan gambar, letakkan gambar baru didekat gambar 

yang sudah dimasukkan tadi. 

 
 

26. Lalu tambahkan teks harga dengan menggunakan Horizontal Type 

Tool. Agar banner menarik perhatian orang. 
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B. Hasil Dan Pembahasan Modul 4 

 

 

Gambar diatas merupakan hasil dari membuat Banner menggunakan 

Adobe Photoshop CS6. Dan pada Pratikum 4 ini saya berhasil membuat  

Banner. 
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MODUL 5 

MEMBUAT SPANDUK MENGGUNAKAN 

ADOBE PHOTOSHOP CS6  

(Pratikum 5) 

 

A. Langkah Kerja 

1. Buka terlebih Adobe Photoshop CS 6. Pilih File > New. 

 
 

2. Kemudian pilih Centimeters, dengan Width 400, Height 120 dan 

Resolution 72. 

 
 

 

 

 

 

2 
1 
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3. Maka akan tampil lembar kerja/kanvas seperti ini. 

 
 

4. Kemudian pilih Rectangle Tool. 

 
 

5. Kemudian tarik ke lembar kerja tadi. Dan bentuk seperti dibawah ini. 

 
 

Lembar kerja/kanvas 
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6. Setelah itu pilih lagi tools Rectangle Tool. 

 
 

7. Dan buatlah bentuk seperti gambar dibawah ini. 

 
 

8. Kemudian klik kanan pada Layer tersebut dan pilih Rasterize Layer. 
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9. Lalu pilih Rectangular Marquee Tool. 

 
 

10. Dan buatlah bentuk seperti gambar dibawah ini.  

 
 

11. Setelah itu, buat Layer baru. 

 

Untuk membuat 

sebuah Layer 

baru. 
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12. Dan pilih Paint Bucket Tool. Kemudian klik kotak yang dibuat 

menggunakan Rectangular Marquee Tool. 

 
 

13. Maka kotak yang dibuat menggunakan Rectangular Marquee Tool 

akan berubah warna. 

 
 

14. Kemudian Ctrl+T pada Layer 1. Dan bentuk seperti gambar dihalaman  

selanjutnya. 
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15. Kemudian klik lama Ctrl, setelah itu klik Layer 1, lalu klik pada Layer 

Rectangle 2 dan tekan Delete. 

 
 

16. Kemudian geser kotak yang dibuat menggunakan Rectangular 

Marquee Tool. Maka akan seperti ini hasilnya. 

 

Geser 
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17. Lalu hapus Layer 1. 

 
 

18. Setelah itu, atur Layer Rectangle 2 letak dan ukurannya seperti gambar 

dibawah ini. 

 
 

19. Kemudian duplikat Layer Rectangle 2, dan atur letak sesuai dengan 

gambar dibawah ini. 

 

Duplikat Layer 

Rectangle 

menjadi 3. 
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20. Kemudian klik pada layer Rectangle 2 copy 2, lalu pilih Drop Shadow. 

 
 

21. Lalu atur Opacity menjadi 60, Angle menjadi 90, Distance menjadi 29, 

Spread menjadi 12, dan Size menjadi 180. 

 
 

22. Kemudian klik pada Layer Rectangle 2, lalu pilih Drop Shadow. 
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23. Lalu atur Opacity menjadi 47, Angle menjadi -4, Distance menjadi 29, 

Spread menjadi 12, dan Size menjadi 100. 

 
 

24. Lalu siapkan gambar gedung direktorat Politeknik Kampar. 

 
 

25. Setelah itu, masukkan gambar tersebut ke lembar kerja. 
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26. Kemudian letakkan Layer 1 dibawah Layer Rectangle 1. 

 
  

27. Setelah itu, klik pada Layer 1 dan klik Add Layer Mask.  

 
 

28. Setelah itu, pilih Gradient Tool. 

 

Posisi gambar 

ditimpa oleh   

Layer Rectangle 

1 

2 
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29. Lalu tarik garis Gradient Tool dari bagian gambar ke arah lembar 

berwarna putih. 

 
 

30. Sehingga seperti ini tampilannya. 

 
 

31. Kemudian siapkan gambar logo Politeknik Kampar. 

 

Tarik 

Hasil setelah 

di Gradient. 



 

55 

 

 

 

 

32. Kemudian letakkan gambar ke lembar kerja. 

 
 

33. Kemudian pilih tools Rectangle Tool. 

 
 

34. Setelah itu, buat kotak kecil seperti ini. 
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35. Kemudian duplikat Layer Rectangle 3, lalu atur letak seperti gambar 

dibawah ini. 

 
 

36. Setelah itu, pilih Ellipse Tool. 

 
 

37. Kemudian bentuk dan duplikat Layer Ellipse 1, sehingga seperti ini 

tampilannya. 

Duplikat Layer 

Rectangle 3 

menjadi 3 Layer 
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38. Kemudian pilih Polygon Tool. 

 
 

39. Setelah itu, buat Sides menjadi 3 agar berbentuk segitiga. Kemudian 

duplikat Layer Polygon 1, sehingga seperti ini tampilannya. 

 
 

Duplikat 

Layer Ellipse 

1 menjadi 4 

buah Layer 

Duplikat 

Layer Polygon 

1 menjadi 5 

Layer. 
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40. Kemudian siapkan gambar seperti dibawah ini. 

 
 

41. Setelah itu, seleksi gambar menggunakan Pen Tool, dan tarik kedua 

gambar ke lembar kerja. 

 
 

42. Lalu, Create a new layer.  

 

Untuk membuat 

Layer baru 
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43. Setelah itu, pilih Brush Tool. 

  
 

44. Kemudian, gerakan Brush Tool didekat lengan foto cewek, agar 

gambar kelihatan lebih nyata. 

 
 

45. Setelah itu, tambahkan teks menggunakan Horizontal Type Tool. 

  

Seperti 

memiliki 

bayangan 
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46. Tambahkan teks seperti gambar dibawah ini. 

 
 

47. Kemudian pilih Rectangular Marquee Tool. 

 
 

48. Kemudian bentuk seperti gambar dibawah ini. 
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49. Setelah itu pilih Gradient. 

  
 

50. Kemudian ubah Angle menjadi 180, dan Gradient ubah menjadi warna 

Orange. 

 
 

51. Maka akan seperti ini tampilan ketika Gradient dan Angle diubah.  

 

1 

2 

2 

1 
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52. Kemudian duplikat Layer Gradient Fill 1. 

 
 

53. Setelah itu, ubah Gradient nya, ubah Angle menjadi 0. 

  
 

54. Maka akan seperti ini tampilannya. 

 

Duplikat Layer 

Gradient Fill 1 

menjadi 2 Layer 

1 

2 
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55. Kemudian seleksi Layer Gradient Fill 1 dan Layer Gradient Fill 1 

copy. Lalu klik kanan dan pilih Merge Layers. 

 
 

56. Maka akan seperti ini tampilannya. 

 
 

57. Setelah itu, pilih Horizontal Type Tool. 
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58. Kemudian tambahkan teks seperti gambar dibawah ini.  

 
 

59. Kemudian siapkan juga icon Facebook, Telepon, dan Web seperti 

dibawah ini. 

 
 

60. Kemudian letak icon pada lembar kerja, setelah itu tambahkan teks 

didekat icon.  
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B. Hasil Dan Pembahasan Modul 5 

 

 

Gambar diatas merupakan hasil dari membuat spanduk menggunakan 

Adobe Photoshop CS6. Dan pada Pratikum 5 ini saya berhasil dalam 

membuat spanduk. 

 

  

Tambahkan 

logo 

Tambahkan 

teks 
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MODUL 6 

MEMBUAT LOGO POLITEKNIK KAMPAR 

MENGGUNAKAN COREL DRAW X7 

(Pratikum 6) 

 

A. Langkah Kerja 

1. Buka terlebih dahulu Corel Draw X7. 

 
 

2. Kemudian, pilih New Document. 

 

 

 

 

Tampilan awal 

Corel Draw X7 
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3. Maka akan muncul tampilan Create a New Document, lalu klik Ok. 

 
 

4. Kemudian, akan muncul tampilan lembar kerja. 

 
 

5. Setelah itu, pilih tools Polygon. 

 

Lembar kerja 

/kanvas 
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6. Kemudian, tarik tools Polygon ke lembar kerja. 

 
  

7. Setelah itu, sesuaikan ukuran Polygon. 

 
 

8. Kemudian, ubah ukuran Outline Width Polygon menjadi 4mm. 
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9. Maka akan seperti ini tampilan Outline Polygon setelah diubah. 

 
 

10. Setelah itu, pilih tools Smear. 

 
 

11. Kemudian, arahkan tools ke bagian Outline Polygon. 

 
 

Outline  

berubah 

menjadi tebal 

Tahan pada Outline 

dan tarik secara pelan, 

agar terbentuk seperti 

pada gambar.  
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12. Bentuklah Polygon hingga seperti gambar dibawah ini. 

 

 

13. Kemudian, berikan warna pada Polygon. 

 

 

14. Maka akan seperti ini tampilan Polygon setelah diberi warna. 

 

Untuk memilih 

warna 
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15. Setelah itu, pilih tools 3-Point Curve. 

 
 

16. Kemudian, bentuk lengkungan menggunakan tools 3-Point Curve. 

 

 

17. Bentuklah lengkungan berkali-kali, sehingga terbentuk seperti daun. 
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18. Setelah itu, pindahkan lengkungan berbentuk daun ke dalam lembar 

kerja. 

 
 

19. Setelah itu, berikan warna pada lengkungan berbentuk daun tersebut. 

 
 

20. Kemudian, hilangkan Outline lengkungan berbentuk daun tersebut.  

 

Seleksi seluruh 

lengkungan 

berbentuk daun, lalu 

tarik ke dalam lembar 

kerja 

Seleksi terlebih 

dahulu 

lengkungan 

berbentuk daun Kemudian 

berikan 

warna 

Pilih None 
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21. Setelah itu, Import logo Politeknik Kampar. 

 
 

 
 

22. Kemudian, pilih tools Pen.  
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23. Setelah itu, seleksi pada bagian logo Politeknik Kampar yang 

diinginkan. 

 
 

24. Kemudian, duplikat bagian yang sudah diseleksi.  

  
 

25. Setelah itu, masukkan hasil duplikat ke dalam lembar kerja. 

. 

1. Ctrl+C 2.Ctrl+V 
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26. Kemudian, sesuaikan letak dan ukurannya. Dan hapus logo Politeknik 

Kampar yang sudah dimasukkan. Sehingga seperti ini tampilannya.  

 
 

27. Setelah itu, simpan project dalam format png. 
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B. Hasil Dan Pembahasan Modul 6 

 

 
 

Gambar diatas merupakan logo Politeknik Kampar yang dibuat 

menggunakan Corel Draw X7. Dan pada Pratikum 6 ini saya berhasil 

membuat logo Politeknik Kampar. 
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MODUL 7 

MEMBUAT LOGO TEKNIK INFORMATIKA 

MENGGUNAKAN COREL DRAW X7 

(Pratikum 7) 

 

A. Langkah Kerja 

1. Buka terlebih Corel Draw X7, pilih New Document. 

 
 

2. Kemudian, akan muncul tampilan Create a New Document. Lalu, ubah 

Width menjadi 350.0 mm, dan Height menjadi 350.0 mm. 

 
 

 

 

 

 

Untuk membuat 

Lembar kerja /kanvas 

baru. 
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3. Maka akan tampil lembar kerja kosong seperti gambar dibawah ini. 

 
 

4. Kemudian, pilih tools Ellipse. 

 
 

5. Setelah itu, buat lingkaran seperti dibawah ini. 

 

Lembar kerja/ 

kanvas 
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6. Kemudian, ubah Outline Width menjadi 4.0 mm, dan ubah warna 

Outline lingkaran menjadi ungu. 

 
 

7. Lalu, duplikat lingkaran dengan menekan Ctrl+D secara bersamaan. 

 
 

8. Setelah itu, sesuaikan letak dan ukuran. Dan berikan warna ungu pada 

lingkaran, dan ubah Outline Width menjadi 3.0 mm. 

 

2.Berikan 

warna 

ungu pada 

Outline 

1.Pilih 4.0 mm 

Pilih 3.0 mm 

Hasil duplikat 
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9. Kemudian, duplikat kembali lingkaran yang berwarna ungu. 

 
 

10. Lalu, sesuaikan letak dan ukurannya. Dan ubah warna menjadi putih, 

dan hilangkan Outline Width-nya.  

 
  

11. Kemudian, duplikat kembali lingkaran yang berwarna putih. 

 

Hasil duplikat 

1.Ubah warna 

menjadi putih 

2.Pilih None 

Hasil duplikat 
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12. Setelah itu, sesuaikan letak dan ukurannya. Dan ubah Outline Width 

menjadi 2.5 mm, dan ubah juga warna Outline lingkaran menjadi ungu. 

 
 

13. Kemudian, pilih tools Text. 

 
 

14. Lalu, buat teks seperti gambar dibawah ini. 

 

1.Pilih 2.5 mm  

2.Ubah warna 

menjadi ungu 
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15. Setelah itu, klik pada teks, pilih menu Text dan pilih Fit Text to Path. 

 
 

16. Kemudian, atur posisi teks sama seperti gambar dibawah ini. 

 

 

17. Setelah itu, tambahkan teks lagi dengan menggunakan tools Text. 

  

1.Klik terlebih 

dahulu pada 

teks 

3 

2 
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18. Buat teks seperti gambar dibawah ini. 

 

 

19. Lalu, klik pada teks, pilih menu Text dan pilih Fit Text to Path. 

 
 

20. Kemudian, atur posisi teks sama seperti gambar dibawah ini.  

 

1.Klik terlebih dahulu 

pada teks 

2 

3 
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21. Lalu, agar teks “Politeknik Kampar” dimulai dari sebelah kiri. Klik 

teks dan klik Mirror Text Horizontally. 

 
  

22. Setelah itu, klik Mirror Text Vertically.  

 
 

23. Maka teks akan dimulai dari sebelah kiri. 
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24. Kemudian, pilih tools Pen. 

 
 

25. Setelah itu, buat bintang seperti gambar dibawah ini. 

 

 

26. Kemudian, duplikat bentuk bintang dan letakkan diantara kedua teks.  
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27. Setelah itu, Import dua buah gambar seperti dibawah ini. 

  
 

28. Kemudian, masukkan kedua buah gambar ke dalam lembar kerja. Dan 

sesuaikan letak dan ukurannya sama seperti gambar dibawah ini. 

 
 

29. Setelah itu, simpan file, pilih File > Export. 

  

1 

2 
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30. Simpan file dengan format JPG. 

   
 

B. Hasil Dan Pembahasan Modul 7 
 

 
 

Gambar diatas merupakan logo Teknik Informatika yang dibuat 

menggunakan Corel Draw X7. Dan pada Pratikum 7 ini saya berhasil 

membuat logo Teknik Informatika. 
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MODUL 8 

MEMBUAT BUKU TAHUNAN MENGGUNAKAN 

ADOBE PHOTOSHOP CS6  

(Pratikum 8) 

 

A. Langkah Kerja 

1. Unduh terlebih dahulu template yang akan digunakan. Bisa di unduh di 

link berikut http://www.mediafire.com/file/e164jdfr57r2tg4/Yearbook 

Photoshop_Template_Design_Retro_Theme.rar/file. 

 
 

2. Setelah itu, Extract  terlebih dahulu file yang telah di unduh. 

 
 

http://www.mediafire.com/file/e164jdfr57r2tg4/Yearbook%20Photoshop
http://www.mediafire.com/file/e164jdfr57r2tg4/Yearbook%20Photoshop
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3. Kemudian, buka template buku tahunan yang sudah di Extract, dengan 

menggunakan Adobe Photoshop CS6. 

 
 

4. Setelah itu, pilih File > Open. 

 
 

5. Setelah itu, pilih template buku tahunan yang akan di edit. 

 

Tampilan awal Adobe Photoshop CS6 

1 
2 

Template yang 

akan di edit 
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6. Maka akan seperti ini tampilan template yang akan di edit. 

 
 

7. Kemudian, ubah orientasi template menjadi potrait. Dengan cara pilih 

Image > Image Size. 

 
 

8. Lalu, ubah Width menjadi 2480 Pixels dan dan Height menjadi 3248 

Pixels.  

 
 

 

 

 

 

1 

2 

Tampilan awal template 
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9. Maka akan seperti ini tampilan ketika orientasi template diubah 

menjadi potrait. 

 
 

10.  Kemudian, hapus Layer 2 dan Layer 14. 

 

Hapus Layer 

Tampilan sebelum 

Layer 1 dan Layer 14 

dihapus 
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11. Setelah itu, buat frame menggunakan Rectangle Tool. 

 
 

 
 

Tampilan sesudah 

Layer 1 dan Layer 14 

dihapus 

Hasil dari 

Rectangle Tool 
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12. Lalu, sesuaikan Blending Options, Stroke, Drop Shadow. Dengan klik 

2 kali pada Layer Rectangle 2. Pada Blending Options, ubah Fill 

Opacity menjadi 0%.  

 
 

13. Lalu, Checklist pada Stroke. Dan ubah size menjadi 32px, ubah 

Position menjadi Inside, dan ubah warna Stroke sesuai dengan warna 

template. 

 
 

14. Setelah itu, Checklist juga pada Drop Shadow. Ubah Opacity menjadi 

36%, ubah Angle menjadi 131, ubah Distance menjadi 39px, dan ubah 

Size menjadi 16px. 

1 

2 

1 

3 

2 
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15. Maka akan seperti ini tampilan frame yang telah dibuat. 

 
 

16. Setelah itu, masukkan gambar. Dengan pilih File > Place. 

 
 

1 

2 

Hasil frame 

1 

2 
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17. Lalu, sesuaikan gambar dengan frame. Klik Layer 12, tekan Ctrl+T 

secara bersamaan, dan sesuaikan ukuran sambil menekan Shift. 

 
 

18. Kemudian, hapus Layer 3, Layer 7 dan Layer five class room. 

 
 

 

1.Klik Layer  

2.Sesuaikan 

gambar dengan 

frame 

Hapus  Layer 

Tampilan template 

sebelum Layer 3, 

Layer 7, dan Layer  

five class room  

Tampilan template 

sesudah Layer 3, 

Layer 7, dan Layer  

five class room  
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19. Dan hapus juga semua Layer teks yang ada pada template. 

 
 

20. Kemudian, pilih Horizontal Type Tool. 

 
 

21. Dan tambahkan teks pada template seperti gambar dibawah ini. 

 

Tampilan template  

ketika semua Layer 

teks dihapus 



 

97 

 

 

 

 

22. Kemudian, ubah angka 5 menjadi 19. Dengan cara klik 2 kali pada 

Layer 5 dan Layer 5 copy.   

 
 

 
 

23. Klik pada Layer 11, lalu atur posisi dan rotasi Layer 11. 

 

Klik 2 kali disetiap 

Layer secara 

bergantian 

Sebelum angka 5 

diubah menjadi 

19 

Sesudah angka 

5 diubah 

menjadi 19 

Klik terlebih dahulu 

Layer, kemudian 

tekan  Ctrl+T 
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24. Kemudian, duplikat Layer 11. Dan sesuaikan posisi seperti gambar 

dibawah ini. 

 
 

25. Setelah itu, sesuaikan posisi Layer f, Layer f copy dan Layer f copy 2 

seperti gambar dibawah ini. 

 

Duplikat Layer 11 

menjadi 2 Layer 

Tampilan Layer 

11 copy 
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26. Maka akan seperti ini hasil template bagian sampul depan. 

 
 

27. Kemudian, buka kembali template yang akan di edit. Dengan cara pilih 

File > Open. 

 
 

28. Maka akan muncul tampilan template yang akan di edit. 

1 
2 
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29. Kemudian, hapus Layer RETROCLASIC, Layer 7 dan Layer 8. 

  

 

 
 

Tampilan awal template 

Hapus Layer 

Tampilan template 

sebelum Layer 

RETROCLASIC, Layer 

7, dan Layer 8 

dihapus  

Tampilan template 

sesudah Layer 

RETROCLASIC, Layer 

7, dan Layer 8 

dihapus  
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30. Setelah itu, masukkan logo Teknik Informatika ke dalam template. 

Dengan cara pilih File > Place. 

 
 

31. Lalu, sesuaikan ukuran dan posisi logo. 

 
 

32. Kemudian, pilih Horizontal Type Tool. 

 

1 

2 
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33. Setelah itu, tambahkan teks seperti pada gambar dibawah ini. 

 
 

34. Desain template diatas digunakan juga pada halaman 9 dan  halaman 

19. Pada halaman 9 dan halaman 19 hanya mengubah pada bagian logo 

dan teks. 

   
 

35. Kemudian, hapus logo dan teks pada template diatas. Menjadi seperti 

dibawah ini. 
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36. Setelah itu, buat frame dengan menggunakan Rectangle Tool. 

 
 

37. Lalu, buat kotak seperti dibawah ini. 

 
 

Hasil dari 

Rectangle Tool 
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38. Kemudian, sesuaikan Blending Options, Stroke, Drop Shadow. Dengan 

klik 2 kali pada Layer Rectangle 1. Pada Blending Options, ubah Fill 

Opacity menjadi 0%. 

 
 

39. Lalu, Checklist pada Stroke. Dan ubah Size menjadi 32px, ubah 

Position menjadi Inside, dan ubah warna Stroke sesuai dengan warna 

template. 

 
 

40. Setelah itu, Checklist juga pada Drop Shadow. Ubah Opacity menjadi 

36%, ubah Angle menjadi 131, ubah Distance menjadi 39px, dan ubah 

Size menjadi 16px. 

1 

2 

1 
2 
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41. Maka akan seperti ini tampilan frame yang telah dibuat. 

 
 

42. Setelah itu, masukkan gambar, dengan pilih File > Place. 

 
 

1 

2 

Frame 

1 

2 
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43. Lalu, sesuaikan gambar dengan frame. Klik Layer Gambar, tekan 

Ctrl+T secara bersamaan, dan sesuaikan ukuran sambil menekan Shift. 

 
 

44. Kemudian, duplikat Layer Rectangle 1, dengan cara klik Layer 

Rectangle 1, lalu tekan Ctrl+J secara bersamaan. 

 
 

45. Kemudian, masukkan gambar. Dan sesuaikan gambar dengan frame. 

Klik Layer Gambar1, tekan Ctrl+T secara bersamaan, dan sesuaikan 

ukuran sambil menekan Shift. 

2. Sesuaikan gambar 

dengan frame 

1. Klik Layer 

Duplikat Layer  

menjadi 2 Layer 

Tampilan Layer 

Rectangle 1 copy 
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46. Setelah itu, tambahkan teks dengan cara pilih Horizontal Type Tool. 

 
 

47. Kemudian, sesuaikan Bevel & Emboss, Stroke, Inner Glow, Satin, 

Color Overlay dan Outer Glow. Dengan klik 2 kali pada Layer 

Fasilitas Teknik Informatika. Pada Bevel & Emboss, sesuaikan 

Structure dan Shading sama seperti dibawah ini. 

Sesuaikan gambar 

dengan frame 
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48. Setelah itu, Checklist pada Stroke. Ubah Structure sama seperti gambar 

dibawah ini. 

 
 

49. Setelah itu, Checklist  juga pada Inner Glow. Ubah Structure, Elements 

dan Quality sama seperti gambar dibawah ini. 

 

1 

2 

1 2 

1 2
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50. Kemudian, Checklist juga pada Satin. Ubah Structure sama seperti 

gambar dibawah ini.  

 
 

51. Lalu, Checklist juga pada Color Overlay. Ubah Color sama seperti 

gambar dibawah ini. 

 
 

52. Yang terakhir Checklist pada Outer Glow. Ubah Structure, Elements 

dan Quality sama seperti gambar dibawah ini. 

1 

2 

1 

2 
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53. Kemudian, duplikat Layer Fasilitas Teknik Informatika. Dengan cara 

klik pada Layer Fasilitas Teknik Informatika, dan tekan Ctrl+J secara 

bersamaan. 

 
 

54. Setelah itu, atur kembali Stroke, Inner Glow, Satin dan Drop Shadow. 

Dengan klik 2 kali pada Layer Fasilitas Teknik Informatika copy. Pada 

Stroke, sesuaikan Structure sama seperti dibawah ini.  

1 

2 

Duplikat Layer Fasilitas 

Teknik Informatika  

menjadi 2 Layer 
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55. Setelah itu, Checklist juga pada Inner Glow. Ubah Structure, Elements 

dan Quality sama seperti gambar dibawah ini.  

 
 

56. Lalu, Checklist juga pada Satin. Ubah Structure sama seperti gambar 

dibawah ini.  

 

1 

2 

1 
2 

1 

2 
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57. Setelah itu, Checklist juga pada Outer Glow. Ubah Structure, Elements 

dan Quality sama seperti gambar dibawah ini. 

 
 

58. Yang terakhir Checklist pada Drop Shadow. Ubah Structure sama 

seperti gambar dibawah ini. 

 
 

59. Kemudian, masukkan icon, dengan cara pilih File > Place. 

 

2 

1 

2 

1 

1 

2 
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60. Setelah itu, sesuaikan ukuran dan posisi icon sama seperti gambar 

dibawah ini. 

 
 

61. Lalu, tambahkan teks diatas icon tersebut. Dengan menggunakan 

Horizontal Type Tool. 

 
 

62. Duplikat Layer selotippng dan Layer Labor Sistem Informasi, dengan 

menekan Ctrl+J secara bersamaan. Sesuaikan posisi hasil duplikat dan 

ubah teks sama seperti gambar dibawah ini. 

Teks dibuat 

menggunakan 

Horizontal Type 

Tool 
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63. Desain template diatas digunakan pada halaman 3 sampai halaman 8. 

Pada halaman 3 sampai halaman 8 hanya merubah pada gambar dan 

teks. 

 

64. Selanjutnya, buka kembali template yang akan di edit. Pilih File > 

Open. 

 
 

65. Kemudian, hapus beberapa Layer teks yang tidak digunakan. 

Tampilan dari Layer 

selotippng dan Layer 

Labor Sistem Informasi  

1 

2 
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66. Setelah itu, klik 2 kali pada Layer RETROCLASIC. Lalu, ubah teks 

“RETROCLASIC” menjadi “INFORMATIKA’19”. 

 
 

Hapus Layer 

Tampilan sebelum 

beberapa Layer 

teks dihapus 

Tampilan sesudah 

beberapa Layer 

teks dihapus 

Tampilan sesudah teks 

RETROCLASIC diubah menjadi 

INFORMATIKA’19 
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67. Kemudian, sesuaikan ukuran frame sama seperti gambar dibawah ini. 

 
 

68. Setelah itu, klik 2 kali pada Layer 9, dan ubah Fill Opacity menjadi 

0%. Agar bagian dalam frame menjadi transparan. 

 
 

69. Lakukan juga pada Layer 7. Maka akan seperti ini tampilannya. 

 

Perkecil ukuran 

frame, dengan 

menekan Ctrl+T 

secara bersamaan 

1 

2 

Tampilan frame sesudah 

Opacity diubah menjadi 

0%  
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70. Kemudian, masukkan gambar ke dalam 2 buah frame tersebut. 

 
 

71. Setelah itu, pilih Horizontal Type Tool untuk menambahkan sebuah 

teks. 

 
 

72. Desain template diatas digunakan pada halaman 10 sampai halaman 

18, dan halaman 20. Dan pada halaman 10 sampai halaman 18, dan 

halaman 20 hanya mengubah pada bagian gambar dan teks. 

 

 

 

 

  

Tampilan ketika 

didalam frame 

dimasukkan gambar 

Teks ditambahkan 

menggunakan 

Hrozontal Type Tool 
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B. Hasil Dan Pembahasan Modul 8 
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Gambar-gambar di lembar sebelumnya merupakan hasil 

pembuatan buku tahunan menggunakan Adobe Photoshop CS6. Pada 

Pratikum 8 ini saya berhasil membuat buku tahunan menggunakan Adobe 

Photoshop CS6. 
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MODUL 9 

MEMBUAT MONOGRAF MENGGUNAKAN 

COREL DRAW X7 

(Pratikum 9) 

 

A. Langkah Kerja 

1. Buka terlebih dahulu Corel Draw X7. 

 
 

2. Kemudian, pilih New Document. 
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3. Setelah itu, akan muncul tampilan Create a New Document. Buat 

Width menjadi 350.0 mm dan Height menjadi 350.0 mm. Lalu, klik 

OK. 

 
 

4. Maka, akan muncul lembar kerja/kanvas. 

 
 

5. Kemudian, pilih Polygon Tool. 

 

1 

Lembar kerja 

/ kanvas 

2 
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6. Setelah itu, ubah Points or Sides menjadi 3. Agar terbentuk menjadi 

segitiga. 

 
 

7. Maka, akan seperti ini tampilan bentuk segitiga yang dibuat 

menggunakan Polygon tool. 

 
 

8. Kemudian, pilih Freehand tool. 

 

Hasil segitiga yang 

dibuat menggunakan 

Polygon tool 
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9. Setelah itu, arahkan tools ke sudut atas segitiga, sehingga muncul kata 

node. 

 
 

10. Kemudian, tarik kembali ke arah sudut bawah bagian sebelah kanan, 

sehingga muncul kata  node. 

 
 

11. Maka, akan seperti ini tampilannya. 

 

Kemudian, tarik ke 

sudut bawah sebelah 

kanan  

Klik pada sudut atas 
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12. Kemudian, duplikat garis yang dibuat menggunakan Freehand tool. 

Dan letakkan dibagian sudut bawah bagian sebelah kiri. 

 
 

13. Setelah itu, pilih Blend tool. 

 
 

14. Kemudian, letakkan Blend tool pada sudut bawah sebelah kiri dan tarik 

ke arah sisi sebelah kanan. 

 

1.Klik pada sudut 

sebelah kiri 

Duplikat, dengan cara 

klik Ctrl+C 
Hasil dari duplikat 

2.Kemudian, tarik ke 

arah sisi segitiga 

sebelah kanan 
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15. Dan ubah pada Blend objects menjadi 12. 

 
 

16. Setelah itu, kelompokkan garis tersebut menjadi Group Objects. 

Dengan cara seleksi semua garis, klik kanan dan pilih Group Objects. 

 
 

17. Kemudian, duplikat Group Objects  garis tersebut. 

 

1.Seleksi 

semua garis 2.Kemudian, klik 

kanan dan pilih 

Group Objects 

Hasil duplikat 

dari Group 

Objects garis  
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18. Setelah itu, duplikat kembali Group Objects garis tersebut sesuai 

dengan kebutuhan. 

 
 

19. Kemudian, pilih Smart Fill tool. 

 
 

20. Setelah itu, pilih warna. 

 

Hasil dari duplikat Group 

Objects  

Pilih warna 
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21. Kemudian, beri warna disetiap kotak sesuai dengan desain monograf 

yang diinginkan. 

 
 

22. Maka, akan seperti ini tampilan ketika kotak sudah diberikan warna 

sesuai dengan desain yang diinginkan. 

 
 

23. Kemudian, seleksi kotak yang sudah diberikan warna. 

 



 

137 

 

 

 

 

24. Setelah itu, tarik keluar dari garis-garis tersebut. 

 
 

25. Kemudian, ubah Outline Width menjadi None. 

 
 

26. Setelah itu, gabungkan dengan cara seleksi sedikit demi sedikit kotak, 

agar semua kotak dapat tergabung. Lalu, klik Weld. 

 

1.Seleksi terlebih 

dahulu kotak-kotak 

2.Klik Weld 
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27. Maka, akan seperti ini tampilan ketika semua kotak yang telah diberi 

warna digabung. 

 
 

28. Kemudian, pilih Ellipse. 

 
 

29. Setelah itu, buat 2 buah lingkaran seperti gambar dibawah ini. 

 

Hasil setelah semua kotak digabung 

dengan menggunakan Weld 

Buat 2 lingkaran dengan 

ukuran besar dan kecil 
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30. Kemudian, pilih Freehand. 

 
 

31. Kemudian, arahkan ke sudut atas sebelah kiri, sehingga muncul kata 

Node, dan klik pada sudut tersebut. 

 
 

32. Lalu, tarik ke arah sudut bawah, sehingga muncul kata Node, dan klik 

pada sudut tersebut. 

 

Tarik ke sudut bawah 
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33. Buat atau duplikat, garis tersebut sama seperti gambar dibawah ini.  

 
 

34. Kemudian, pilih Smart Fill tool. 

 
 

35. Kemudian, berikan warna dibagian dalam sisi lingkaran. 
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36. Setelah itu, hapus garis yang dibuat menggunakan Freehand. 

 
 

37. Kemudian, seleksi pada bagian desain monograf. Lalu, klik Combine. 

 
 

38. Setelah itu, hapus garis-garis yang digunakan untuk membuat pola, dan 

letakkan desain monograf di lembar kerja/kanvas.  

 

1 

Hilangkan garis-garis yang dibuat 

menggunakan Freehand dengan cara klik 

pada garis, dan tekan delete 

2 
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39. Kemudian, Export project. Dengan cara pilih menu File > Export. 

 
 

40. Simpan dengan format JPG, lalu klik Export. 

 
 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2 

1 

2 

1 
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B. Hasil Dan Pembahasan Modul 9 

 

 

Gambar diatas merupakan monograf yang dibuat menggunakan 

Corel Draw X7. Dan pada Pratikum 9 ini saya berhasil dalam membuat 

monograf. 
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MODUL 1 

MEMBUAT DESIGN WEB MENGGUNAKAN APLIKASI 

ADOBE PHOTOSHOP CS6 DAN ADOBE DREAMWEAVER CS6 

(Pratikum 1) 

 

A. Langkah Kerja 

1. Buka aplikasi Adobe Photoshop CS6 yang sudah di install. 

2. Buatlah lembar kerja baru dengan cara tekan “CTRL+N” pada keyboard. 

Atur ukurannya menjadi 750 x 150 pixels dengan resolusi 300 pixel/inch. 

 

 

3. Mengatur warna kertas 

 

a 
Mengatur warna dengan 

menggeser tanda 
Mengatur warna berdasarkan 

kode warna 

 

Setelah 

selesai 

klik OK 

1 

2 
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4. Hasil pewarnaan kertas menggunakan “Paint Bucket Tool (G)”. 

 

 

5. Buatlah tulisan menggunakan “Horizontal Type Tool(T)”. Untuk 

pewarnaan bisa pilih warna sesuai kebutuhan. 

 

 

Arahkan mouse 

ke kertas 

Arahkan mouse 

ke kertas 

Mengatur 

warna kertas 

Mengatur 

warna tulisan 
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6. Pada menu “File name” buat name file sesuai yang di inginkan dan pada 

menu “Format” pilih format sesuai yang di butuhkan, lalu klik “save”. 

 

 

7. Pada pengaturan JPEG Options, atur sesuai dengan kebutuhan. Lalu klik 

“OK”. 

 

 

1 

2 

1 

2 
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8. Buatlah lembar kerja baru dengan cara tekan “CTRL+N” pada keyboard. 

Atur ukurannya menjadi 150 x 50 pixels dengan resolusi 300 pixel/inch. 

 

 

9. Mengatur warna kertas. 

 

 

10. Hasil pewarnaan kertas menggunakan “Paint Bucket Tool (G)”.  

1 

2 

a 

Mengatur warna berdasarkan 

kode warna 

 
Setelah 

selesai 

klik OK 

Mengatur warna dengan 

menggeser tanda 
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11. Buatlah tulisan menggunakan “Horizontal Type Tool(T)”. Untuk 

pewarnaan bisa pilih warna sesuai kebutuhan. 

 

 

12. Pada menu “File name” buat name file sesuai yang di inginkan dan pada 

Arahkan mouse 

ke kertas 

Mengatur 

warna kertas 

Mengatur 

warna tulisan 

Arahkan mouse 

ke kertas 
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menu “Format” pilih format sesuai yang di butuhkan, lalu klik “save”. 

 

 

13. Pada pengaturan JPEG Options, atur sesuai dengan kebutauhan. Lalu klik 

“OK”. 

 

 

 

1 
2 

1 

2 
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14. Membuat warna pada pinggiran tulisan. Pilih Layer > Layer Style > Style. 
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15. Hasil membuat warna pada pinggiran tulisan. 

 

 

16. Pada menu “File name” buat name file sesuai yang di inginkan dan pada 

menu “Format” pilih format sesuai yang di butuhkan, lalu klik “save”. 

 

 

 

Hasil pemberian warna 

pada pinggiran tulisan 

1 2 
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17. Pada pengaturan JPEG Options, atur sesuai dengan kebutauhan. Lalu klik 

“OK”. 

 

 

18. Lalu klik kanan pada menu “Layers” lalu pilih “Duplicate layer”, lalu 

klik “OK”. 

 

 

1 

2 
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19. Kemudian matikan tanda mata pada layer yang telah selesai di edit. 

 

 

20. Ulangi dari langkah nomor 11 – 19, untuk menghasilkan design seperti 

berikut : 
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21. Buat folder untuk web nya. 

 

 

22. Buka aplikasi Adobe Dreamweaver CS6 yang sudah di install. 

23. Buat folder untuk web nya. 

24. Pada menu “Site” pilih “New Site”. 

2 

1 
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25. Pada menu “Site” atur “Site Name” sesuai dengan folder yang dibuat, 

lalu pada “Local Site Folder” dimana folder tersebut diletakkan. 

 

2. Mengatur nama site dan  

lokasi folder site 

1 
2 

1 
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26. Pada menu “Advanved Settings” pilih “Local Info” dan atur “Default 

Image folder” dimana folder yang berisikan foto yang telah dibuat tadi di 

Photoshop. Lalu klik “Save”. 

 

 

27. Pada tampilan awal Dreamweaver pilih “HTML”. 

 

 

 

1 

2 

3 
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28. Membuat table, pilih Insert > Table. 

 

 

29. Ukuran table. 

 

 

 

1 

2 

1. Mengatur ukuran tabel 

2. Klik OK 
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30. Letakkan tabel di tengah. 

 

 

31. Masukkan gambar, pilih Insert > Image Objects > Rollover Image 

 

 

32. Atur nama gambar dan letak gambar yang sesuai. 

 

 

33. Lakukan langkah nomor 31 dan 32, untuk menghasilkan tampilan seperti 

ini. 

1 

2 3 

1. Mengatur nama gambar 

2. Masukkan gambar 1 

3. Masukkan gambar 2 

4. Mengatur nama URL 

5. Klik OK 
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34. Tambahkan table, pilih Insert > Table. 

 

 

35. Ukuran table. 

Hasilnya 

1 

2 
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36. Letakkan tabel di tengah. 

 

 

37. Masukkan gambar. 

 

1 

2 
3 

1. Mengatur ukuran tabel 

2. Klik OK 
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38. Atur nama gambar dan letak gambar yang sesuai. 

 

 

39. Tambahkan table, pilih Insert > Table. 

 

 

40. Ukuran table. 

 

 

 

1. Mengatur nama gambar 

2. Memasukkan gambar 1 

3. Memasukkan gambar 2 

4. Mengatur nama URL 

5. Klik OK 

1 

2 

1. Mengatur ukuran tabel 

2. Klik OK 



 

165 

 

 

 

 

41. Membuat tulisan dan atur menjadi “Heading 1”. 

 

 

 

42. Lalu pada menu “File” pilih “Save As” dan atur nama file nya sesuai 

gambar dibawah ini. 

 

1 

2 
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B. Hasil dan Pembahasan 

 

Pada gambar di atas adalah membuat Design Web dengan menggunakan 

aplikasi Adobe Photoshop CS6 dan Adobe Dreamweaver , sehingga membuat 

Design Web berhasil di lakukan, karena saya mengikuti pedoman yang saya 

lihat/dapatkan. 

1 
2 
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MODUL 2 

MEMBUAT DESIGN WEB MENGGUNAKAN APLIKASI 

ADOBE PHOTOSHOP CS6 DAN ADOBE DREAMWEAVER CS6 

(Pratikum 2) 

 

A. Langkah Kerja 

1. Buka aplikasi Adobe Photoshop CS6 yang sudah di install. 

2. Buatlah lembar kerja dengan cara tekan “CTRL+N” pada keyboard. Atur 

ukurannya menjadi 783 x 410 pixels dengan resolusi 72 pixel/inch. 

 

 

 

 

 

1 

2 
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3. Memasukkan gambar, pilih File > Plate dan masukkan gambar yang 

diinginkan. 

 

 

4. Hasil dari memasukkan gambar. 

 

 

1 

2 
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5. Buatlah tulisan menggunakan “Horizontal Type Tool(T)”. Untuk 

pewarnaan bisa pilih warna sesuai kebutuhan. 

 

 

6. Hasil dari memasukkan tulisan. 
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7. Buatlah bentuk bulat menggunakan “Costum Shapes Tool (U)”. Untuk 

pewarnaan bisa pilih warna sesuai kebutuhan. 

 

 

8. Hasil dari membuat lingkaran. 

 

 

1 

2 
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9. Buatlah tulisan menggunakan “Horizontal Type Tool(T)”. Untuk 

pewarnaan bisa pilih warna sesuai kebutuhan. 

 

 

10. Hasil dari membuat tulisan. 
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11. Buatlah lembar kerja baru dengan cara tekan “CTRL+N” pada keyboard. 

Atur ukurannya menjadi 783 x 410 pixels dengan resolusi 72 pixel/inch. 

 

 

12. Mengatur warna canvas. 

 

1 

2 
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13. Hasil perwarnaan canvas menggunakan “Paint Bucket Tool (G)”. 

 

 

14. Memasukkan foto, pilih File > Plate. 

 

 

Hasil kertas setelah 

diberi warna 

Mengatur warna 

kertas 

Arahkan mouse 

ke kertas 

1 

2 
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15. Hasil dari memasukkan foto. 

 

 

16. Buatlah bentuk kotak menggunakan “Costum Shapes Tool (U)”. Untuk 

pewarnaan bisa pilih warna sesuai kebutuhan. 

 

 

 

1 

2 
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17. Hasil dari membuat bentuk kotak. 

 

 

18. Buatlah tulisan menggunakan “Horizontal Type Tool(T)”. Untuk 

pewarnaan bisa pilih warna sesuai kebutuhan. 
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19. Hasil dari membuat tulisan. 

 

 

20. Buatlah lembar kerja baru dengan cara tekan “CTRL+N” pada keyboard. 

Atur ukurannya menjadi 783 x 410 pixels dengan resolusi 72 pixel/inch. 

 

 

 

1 

2 
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21. Mengatur warna canvas. 

 

 

22. Hasil perwarnaan canvas menggunakan “Paint Bucket Tool (G)”. 

 

 

Hasil kertas setelah 

diberi warna 

Mengatur warna 

kertas 

Arahkan mouse 

ke kertas 
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23. Buatlah tulisan menggunakan “Horizontal Type Tool(T)”. Untuk 

pewarnaan bisa pilih warna sesuai kebutuhan. 

 

 

24. Hasil dari membuat tulisan. 

 

 

Mengatur warna 

tulisan 
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25. Kemudian siapkan pas foto yang akan digunakan. 

 

 

26. Maka hasilnya akan seperti gambar dibawah ini. 
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27. Buatlah lembar kerja baru dengan cara tekan “CTRL+N” pada keyboard. 

Atur ukurannya menjadi 783 x 410 pixels dengan resolusi 72 pixel/inch. 

 

 

28. Mengatur warna canvas. 

 

 

 

1 

2 
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29. Hasil perwarnaan canvas menggunakan “Paint Bucket Tool (G)”. 

 

 

30. Memasukkan gambar. 

 

 

Hasil kertas setelah 

diberi warna 

Mengatur warna 

kertas 

Arahkan mouse 

Ke kertas 

1 

2 
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31. Hasil dari memasukkan gambar. 

 

 

32. Buatlah lembar kerja baru dengan cara tekan “CTRL+N” pada keyboard. 

Atur ukurannya menjadi 783 x 410 pixels dengan resolusi 72 pixel/inch. 

 

 

1 

2 
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33. Mengatur warna canvas. 

 

 

34. Hasil perwarnaan canvas menggunakan “Paint Bucket Tool (G)”. 

 

 

Hasil kertas setelah 

diberi warna 

Mengatur warna 

kertas 

Arahkan mouse 

ke kertas 
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35. Memasukkan icon. 

 

 

36. Hasil dari memasukkan icon. 

 

 

Crop icon 

yang dinginkan 
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37. Buatlah tulisan menggunakan “Horizontal Type Tool(T)”. Untuk 

pewarnaan bisa pilih warna sesuai kebutuhan. 

 

 

38. Hasil dari membuat tulisan. 

 

 

Mengatur warna 

tulisan 



 

186 

 

 

 

 

39. Selanjutnya, simpan gambar. Pada menu file pilih “Save atau Save As”.  

 

 

40. Pada menu “File name” buat name file sesuai yang di inginkan dan pada 

menu “Format” pilih format sesuai yang di butuhkan, lalu klik “save”. 

 

1 

2 

1 
2 
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41. Pada pengaturan JPEG Options, atur sesuai dengan kebutauhan. Lalu klik 

“OK”. Lakukan hal yang sama juga untuk design yang telah dibuat. 

 

 

42. Buka aplikasi Adobe Dreamweaver CS6 yang sudah di install. 

43. Buka project yang telah dibuat. 
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44. Hasil project sebelumnya. 

 

 

45. Mengganti tulisan yang ada di menu home menjadi dalam bentuk gambar. 

 

 

1 

2 
3 
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46. Masukkan gambar yang telah dibuat sebelum nya di phooshop. Lalu atur 

nama gambar dan letakkan gambar yang sesuai. 

 

 

47. Hasil setelah diganti menjadi gambar. 

 

 

1. Mengatur nama gambar 

2. Masukkan gambar 1 

3. Masukkan gambar 2 

4. Mengatur nama URL 

5. Klik OK 
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48. Untuk mengganti tulisan yang ada di menu profile, galeri, produk, dan 

contact, ulangi langkah nomor 46 – 47 untuk menghasilkan gambar 

seperti dibawah ini. 
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49. Selanjutnya simpan setiap project yang telah diubah. 

 

 

50. Jalankan project. 

 

 

1 

2 
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B. Hasil dan Pembahasan 
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Pada gambar di atas adalah membuat Design Web dengan menggunakan 

aplikasi Adobe Photoshop CS6 dan Adobe Dreamweaver , sehingga membuat 

Design Web berhasil di lakukan, karena saya mengikuti pedoman yang saya 

lihat/dapatkan. 
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MODUL 3 

MEMBUAT DESIGN WEB TENTANG CV 

MENGGUNAKAN APLIKASI SUBLIME TEXT 

(Pratikum 3) 

 

A. Langkah Kerja 

1. Buka aplikasi Sublime Text yang sudah di install. 

2. Membuat file baru dengan cara “Ctrl+N” pada keyboard atau klik menu 

file dan pilih “New File”. 

 

 

1 

2 
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3. Setelah itu, simpan file yang telah dibuat dengan cara “Ctrl+S” pada 

keyboard atau klik menu file dan pilih “Save”. 

 

 

4. Membuat nama file. 

 

 

1 

2 

1 

2 
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5. Selanjutnya membuat source code dengan menggunakan html. Tahap 

pertama yaitu membuat tabel nya terlebih dahulu yang terdiri dari 11 baris 

dan 7 kolom . 

 

 

Baris 1 

Baris 2 

Baris 3 

Baris 4 

Baris 5 

Baris 6 

Baris 7 

Ukuran tabel 
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6. Kemudian kita lihat hasilnya, dengan cara klik kanan pada mouse dan 

pilih “Open in Browser”. 

 

 

Baris 8 

Baris 9 

Baris 10 

Baris 11 
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7. Hasil dari tahap pertama. 

 

 

8. Tahap kedua yaitu menggabungkan kolom dan baris dari tabel yang telah 

dibuat. 

 

Baris 1 

Baris 2 

Baris 3 

Baris 4 

Baris 5 
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9. Hasil dari tahap kedua. 

 

 

Baris 6 

Baris 7 

Baris 8 

Baris 9 

Baris 10 

Baris 11 
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10. Tahap ketiga yaitu mengisi judul pada tabel. 

 

 

 

Baris 1 

Baris 2 

Baris 3 

Baris 4 

Baris 5 

Baris 6 

Baris 7 

Baris 8 

Baris 9 

Baris 10 

Baris 11 
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11. Hasil dari tahap ketiga. 

 

 

12. Tahap keempat yaitu mengisi data pada tabel. 

 

Baris 1 

Baris 2 

Baris 3 

Baris 4 
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Baris 5 

Baris 6 

Baris 7 

Baris 9 

Baris 8 
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13. Hasil dari tahap keempat. 

 

 

Baris 10 

Baris 11 
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14. Selanjutnya membuat source code dengan menggunakan css. Tahap 

pertama yaitu membuat file nya terlebih dahulu.  

 

 

15. Membuat nama file. 
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16. Membuat source code css nya. 

 

 

17. Menghubungkan file html dan file css yang telah dibuat. 

 

Mengubungkan file html 

dengan css 

Baris 1 

Baris 2 

Baris 3 



 

208 

 

 

 

 

 

 

Baris 4 

Baris 5 

Baris 6 

Baris 7 

Baris 8 

Baris 9 
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18. Penjelasan 

 <!DOCTYPE> adalah untuk menentukan tipe dokumen 

 <html> adalah untuk membuat sebuah dokumen HTML. 

 <head> adalah kepala dari dokumen HTML atau elemen sebagai 

tempat untuk meta data (kumpulan data tentang data). Meta data 

HTML adalah data tentang dokumen HTML itu sendiri, segala 

informasi mengenai meta data tidak akan ditampilkan dalam halaman 

web browser, cara untuk memerikasanya adalah dengan melihat 

langsung source code HTML. 

 <title> adalah untuk membuat judul dari sebuah halaman. 

 <body> adalah tempat dibuatnya semua konten website menggunakan 

HTML. 

 <table> adalah untuk membuat tabel. 

 <link> adalah untuk membuat hubungan antara dokumen dan sumber 

daya eksternal (paling sering digunakan untuk link ke style sheet). 

Baris 10 

Baris 11 
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 <tr> adalah untuk membuat baris dalam sebuah tabel. 

 <td> adalah untuk membuat sel/kolom dalam sebuah tabel. 

 <img> adalah untuk mendefinisikan gambar. 

 <ul> adalah untuk membuat tampilan daftar menggunakan simbol 

seperti bullet, cyrcle, dan lainnya. 

 <li> adalah untuk membuat sebuah item daftar. 

 <br> adalah untuk membuat baris baru. 

 <a> adalah untuk membuat hyperlink. 

 border adalah untuk mengatur ukuran garis tabel. 

 width adalah untuk mengatur lebar sesuatu secara keseluruhan. 

 rel adalah untuk menunjukkan bahwa file yang dirujuk adalah file 

stylesheet (CSS). 

 type adalah berfungsi sebagai kolom isian dari user. 

 href adalah untuk menentukkan lokasi file (CSS) yang ingin 

disisipkan. 

 colspan adalah menggabungkan beberapa kolom. 

 class adalah selector yang dapat kita digunakan oleh lebih dari satu 

tag html. Artinya beberapa tag html bisa menggunakan css dari class 

tersebut. Tag class dengan nama yang sama dapat dipakai berulang-

ulang pada satu halaman. 

 rowspan adalah menggabungkan beberapa baris. 

 src adalah merujuk pada file yang ingin kita masukkan (seperti foto). 

 alt adalah untuk menentukan teks alternatif yang akan ditampilkan 

saat foto tidak dapat ditampilkan. 
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B. Hasil dan Pembahasan 

 

Pada gambar di atas adalah membuat Design Web dengan menggunakan 

HTML dan CSS dengan aplikasi Sublime Text, sehingga membuat Design 

Web berhasil di lakukan, karena saya mengikuti pedoman yang saya 

lihat/dapatkan. 
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MODUL 4 

MEMBUAT DESIGN WEB SEDERHANA 

MENGGUNAKAN APLIKASI SUBLIME TEXT 

(Pratikum 4) 

 

A. Langkah Kerja 

1. Buka aplikasi Sublime Text yang sudah di install. 

2. Membuat folder baru. 

 

 

3. Membuat file baru dengan cara “Ctrl+N” pada keyboard atau klik menu 

file dan pilih “New File”. 

1 

2 
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4. Setelah itu, simpan file yang telah dibuat dengan cara “Ctrl+S” pada 

keyboard atau klik menu file dan pilih “Save”. 

 

 

1 

2 

1 

2 
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5. Simpan di folder yang telah dibuat dan buat nama file dengan type (.html). 

 

 

6. Selanjutnya membuat source code dengan menggunakan html. Berikut 

adalah source code untuk membuat header. 

 

 

1. Membuat nama file 

dengan type .html 

2. Lalu klik save 

Source code 

untuk membuat header 
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7. Hasil dari pembutan header. 

 

 

8. Mempercantik header dengan menggunakan css. Buat file baru dengan 

cara “Ctrl+N” pada keyboard atau klik menu file dan pilih “New File”. 

 

 

1 

2 
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9. Setelah itu, simpan file yang telah dibuat dengan cara “Ctrl+S” pada 

keyboard atau klik menu file dan pilih “Save”. 

 

 

10. Simpan di folder yang telah dibuat dan buat nama file dengan type (.css). 

 

 

1 

2 

1. Membuat nama file 

dengan type .html 

2. Lalu klik save 
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11. Selanjutnya, membuat source code untuk mempercantik tampilan header 

di css. 

 

 

12. Menambahkan source code untuk pemanggilan css di html. 

 

 

Source code untuk mempercatik 

tampilam header di css 

Untuk pemanggilan file css nya 

 
Untuk pemanggilan class yang ada di css nya 
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13. Hasil dari untuk tampilan header. 

 

 

14. Selanjutnya, membuat file baru dengan cara “Ctrl+N” pada keyboard atau 

klik menu file dan pilih “New File”. 

 

 

1 

2 
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15. Setelah itu, simpan file yang telah dibuat dengan cara “Ctrl+S” pada 

keyboard atau klik menu file dan pilih “Save”. 

 

 

16. Buat nama file dengan type (.html). 

 

 

1 

2 

1. Membuat nama file 

dengan type .html 

2. Lalu klik save 
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17. Selanjutnya membuat source code dengan menggunakan html. Berikut 

adalah source code untuk membuat menu bar. 

 

 

18. Hasil dari pembuatan menu bar. 

 

 

Source code 

untuk membuat menu bar 
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19. Selanjutnya, membuat source code untuk mempercantik tampilan menu 

bar di css. 

 

 

20. Menambahkan source code untuk pemanggilan css di html. 

 

 

Source code untuk mempercatik 

tampilam header di css 

Untuk pemanggilan file css nya 

 
Untuk pemanggilan class yang ada di css nya 
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21. Hasil dari mempercantik menu bar. 

 

 

22. Selanjutnya, membuat file baru dengan cara “Ctrl+N” pada keyboard atau 

klik menu file dan pilih “New File”. 
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23. Setelah itu, simpan file yang telah dibuat dengan cara “Ctrl+S” pada 

keyboard atau klik menu file dan pilih “Save”. 

 

 

24. Buat nama file dengan type (.html). 
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25. Selanjutnya membuat source code dengan menggunakan html. Berikut 

adalah source code untuk membuat content. 

 

 

26. Hasil dari pembuatan content. 
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27. Selanjutnya, membuat source code untuk mempercantik tampilan menu 

bar di css. 

 

 

28. Menambahkan source code untuk pemanggilan css di html. 
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29. Hasil dari tampilan content. 

 

 

30. Selanjutnya, membuat file baru dengan cara “Ctrl+N” pada keyboard atau 

klik menu file dan pilih “New File”. 
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31. Setelah itu, simpan file yang telah dibuat dengan cara “Ctrl+S” pada 

keyboard atau klik menu file dan pilih “Save”. 

 

 

32. Buat nama file dengan type (.html). 
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33. Selanjutnya membuat source code dengan menggunakan html. Berikut 

adalah source code untuk membuat footer. 

 

 

34. Hasil dari pembuatan footer. 
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35. Selanjutnya, membuat source code untuk mempercantik tampilan footer 

di css. 

 

 

36. Menambahkan source code untuk pemanggilan css di html. 
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37. Hasil dari mempercantik footer. 

 

 

38. Selanjutnya, membuat file baru dengan cara “Ctrl+N” pada keyboard atau 

klik menu file dan pilih “New File”. 
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39. Setelah itu, simpan file yang telah dibuat dengan cara “Ctrl+S” pada 

keyboard atau klik menu file dan pilih “Save”. 

 

 

40. Buat nama file dengan type (.html). 
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41. Selanjutnya menggabungkan semua source code yang telah dibuat dengan 

menggunakan html. 
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42. Hasil dari menggabungkan semua source code yang telah dibuat. 

 

 

43. Selanjutnya menambahkan isi content. 
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44. Hasil dari menambahkan isi content. 

 

 

45. Setelah itu, merubah tata letak isi content, dengan menggunakan css. 
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46. Selanjutnya, merubah source code di content nya untuk pemanggilan css 

di html. 

 

 

47. Hasil dari merubah tata letak isi content. 
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48. Berikutnya, menambahkan gambar dan membuat garis tepi untuk di 

gambar nya dengan menambahkan source code di html. 

 

 

49. Menambahkan class di css, untuk pemanggilan di html. 
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50. Hasil dari menambahkan gambar dan membuat garis tepi untuk di gambar 

nya. 

 

 

51. Selanjutnya, membuat menu bar apabila di scroll akan tetap / isi dari 

website tersebut yang di scroll. Tahap pertama yaitu menambahkan 

source code di html nya. 
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52. Lalu, menambahkan class di css untuk pemanggilan di html nya. 

 

 

53. Hasil dari membuat menu bar apabila di scroll akan tetap / isi dari 

website tersebut yang di scroll. 
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54. Berikut adalah source code keseluruhan yang ada di html. 
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55. Berikut adalah source code keseluruhan yang ada di css. 
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56. Penjelasan : 

 <!DOCTYPE> adalah untuk menentukan tipe dokumen 

 <html> adalah untuk membuat sebuah dokumen HTML. 

 <head> adalah kepala dari dokumen HTML atau elemen sebagai 

tempat untuk meta data (kumpulan data tentang data). Meta data 

HTML adalah data tentang dokumen HTML itu sendiri, segala 

informasi mengenai meta data tidak akan ditampilkan dalam halaman 

web browser, cara untuk memerikasanya adalah dengan melihat 

langsung source code HTML. 

 <title> adalah untuk membuat judul dari sebuah halaman. 

 <body> adalah tempat dibuatnya semua konten website menggunakan 

HTML. 

 <link> adalah untuk membuat hubungan antara dokumen dan sumber 

daya eksternal (paling sering digunakan untuk link ke style sheet). 

 <meta> adalah elemen atau tag dalam bahasa pemrograman HTML 

atau XHTML yang berfungsi sebagai pemberi informasi metadata dari 

sebuah halaman web. Elemen meta ini harus diletakkan pada bagian 

“head” dalam HTML tersebut. 

 <img> adalah untuk mendefinisikan gambar. 

 <a> adalah untuk membuat hyperlink. 

 <h1 – h6>  adalah sebuah code html yang berfungsi untuk mengubah 

tulisan. tag heading biasa di gunakan untuk membuat judul pada 

sebuah artikel atau dokument. spesifikasi tag heading mempunyai 

berbagai tingkatan yang biasa di sebut h1, h2, h3, h4, h5 dan h6 yang 

masing masing mempunyai fungsi yang berbeda. 

 <div> adalah untuk mengelompokkan elemen atau tag-tag agar 

menjadi suatu grup. Tag div ini juga sering digunakan untuk 

mendefinisikan id atau class dari css. 

 <p> adalah untuk menunjukan sebuah paragraf. 

 rel adalah untuk menunjukkan bahwa file yang dirujuk adalah file 
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stylesheet (CSS). 

 type adalah berfungsi sebagai kolom isian dari user. 

 href adalah untuk menentukkan lokasi file (CSS) yang ingin 

disisipkan. 

 class adalah selector yang dapat kita digunakan oleh lebih dari satu 

tag html. Artinya beberapa tag html bisa menggunakan css dari class 

tersebut. Tag class dengan nama yang sama dapat dipakai berulang-

ulang pada satu halaman. 

 src adalah merujuk pada file yang ingin kita masukkan (seperti foto). 

 alt adalah untuk menentukan teks alternatif yang akan ditampilkan 

saat foto tidak dapat ditampilkan. 

 margin adalah digunakan untuk mengaplikasikan jarak tepi pada 

sebuah elemen bagian luar (tepi garis luar). Margin memiliki 4 macam 

penjabaran yang dapat digunakan secara terpisah sendiri-sendiri, 

yaitu: margin-top , margin-right , margin-bottom dan margin-left . 

 background-color adalah untuk mengatur pewarnaaan dari suatu latar 

belakang pada selecto r(elemen html). 

 padding adalah sebutan untuk spasi atau ruang diantara konten dan 

border. 

 text-align adalah untuk mengatur posisi text. 

 color adalah untuk mengatur pewarnaan pada tulisan. 

 text-transfrom adalah untuk membuat sebuah teks menjadi besar atau 

kecil semua, atau membuat setiap kata dikapitalisasi. 

 overflow adalah untuk menentukan suatu konten apakah nantinya 

konten akan ditambahkan scrollbar ketika konten yang terdapat pada 

elemen tidak cukup muat. Terdapat 4 nilai dari properti overflow yaitu 

: visible, hidden, scrool dan auto. 

 float berfungsi untuk mengatur letak element secara horizontal. ada 

empat value yang bisa di gunakan untuk property float, yaitu left, 

right, inherit dan none. 
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 display adalah untuk mengatur tampilnya suatu elemen. 

 text-decoration adalah untuk mengatur efek garis pada suatu kata 

didalam HTML. Pembagiannya ada 3 yaitu underline, line-trough dan 

overline. 

 font-size adalah untuk mengatur ukuran tulisan yang ada di dalam 

html. 

 hover adalah untuk mengatur link yang sedang di tunjuk oleh pointer 

atau tanda panah yang selalu mengikuti perintah mouse & touchpad 

pada komputer, laptop atau ponsel yang terjadi sebelum adanya proses 

tekan pointer. 

 width adalah untuk mengatur lebar sesuatu secara keseluruhan. 

 content digunakan untuk memasukan atau menyisipkan sebuah 

karakter lain ke dalam tag HTML dibagian awal tag (:before) dan 

bagian akhir tag (:after). 

 clear digunakan untuk membersihkan element yang sebelumnya telah 

mengalami float. Sehingga, element yang di clear akan berpisah dari 

element yang mengalami float dan akan berpindah pada baris baru. 

 @media adalah sebuah teknik css layout yang membebaskan kita 

untuk menyeting tampilan dengan CSS di berbagai resolusi dan lebar, 

tinggi daripada browser yang sedang kita gunakan secara spesifik. 

Maksudnya adalah, kita bisa dengan bebas menyeting layout pada 

ukuran 1024 x 800 atau 800 x 400 misalnya, just whatever you want. 
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B. Hasil dan Pembahasan 

 

 

Pada gambar di atas adalah membuat Design Web dengan menggunakan 

HTML dan CSS dengan aplikasi Sublime Text, sehingga membuat Design 

Web berhasil di lakukan, karena saya mengikuti pedoman yang saya 

lihat/dapatkan. 
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MODUL 5 

MEMBUAT DESIGN WEB DENGAN TEMA E-COMMERCE 

MENGGUNAKAN APLIKASI SUBLIME TEXT 

(Pratikum 5) 

 

A. Langkah Kerja 

1. Buka aplikasi Sublime Text yang sudah di install. 

2. Membuat folder baru. 

 

 

3. Membuat file baru dengan cara “Ctrl+N” pada keyboard atau klik menu 

file dan pilih “New File”. 

1 

2 
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4. Setelah itu, simpan file yang telah dibuat dengan cara “Ctrl+S” pada 

keyboard atau klik menu file dan pilih “Save”. 

 

 

1 

2 

1 

2 
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5. Simpan di folder yang telah dibuat dan buat nama file dengan type (.html). 

 

 

6. Selanjutnya membuat source code dengan menggunakan html. Berikut 

adalah source code untuk membuat index. 

 

1. Membuat nama file 

dengan type .html 

2. Lalu klik save 
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7. Penjelasan : 

 <!DOCTYPE> adalah untuk menentukan tipe dokumen 

 <html> adalah untuk membuat sebuah dokumen HTML. 

 <head> adalah kepala dari dokumen HTML atau elemen sebagai 

tempat untuk meta data (kumpulan data tentang data). Meta data 

HTML adalah data tentang dokumen HTML itu sendiri, segala 

informasi mengenai meta data tidak akan ditampilkan dalam halaman 

web browser, cara untuk memerikasanya adalah dengan melihat 

langsung source code HTML. 

 <link> adalah untuk membuat hubungan antara dokumen dan sumber 

daya eksternal (paling sering digunakan untuk link ke style sheet). 

 <title> adalah untuk membuat judul dari sebuah halaman. 

 <body> adalah tempat dibuatnya semua konten website menggunakan 

HTML. 

 <header> adalah tempat untuk konten pengantar atau sekumpulan 

tautan navigasi. biasanya berisi : satu atau lebih elemen heading (<h1> 

- <h6>), logo atau ikon,dan informasi kepenulisan 

 <h1 – h6> adalah sebuah code html yang berfungsi untuk mengubah 

tulisan. tag heading biasa di gunakan untuk membuat judul pada 

sebuah artikel atau dokument. spesifikasi tag heading mempunyai 

berbagai tingkatan yang biasa di sebut h1, h2, h3, h4, h5 dan h6 yang 

masing masing mempunyai fungsi yang berbeda. 

 <div> adalah untuk mengelompokkan elemen atau tag-tag agar 

menjadi suatu grup. Tag div ini juga sering digunakan untuk 

mendefinisikan id atau class dari css. 

 <ul> adalah untuk membuat tampilan daftar menggunakan simbol 

seperti bullet, cyrcle, dan lainnya. 

 <li> adalah untuk membuat sebuah item daftar. 

 <a> adalah untuk membuat hyperlink. 
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 <aside> adalah untuk menandai bagian web yang bukan berisi konten 

utama, tetapi memiliki kaitan dengan artikel yang saat ini ditampilkan. 

 <img> adalah untuk mendefinisikan gambar. 

 <br> adalah untuk membuat baris baru. 

 <section> adalah digunakan untuk memisahkan bagian-bagian dari 

struktur web. Tag ini bisa digunakan sebagai container untuk 

kumpulan artikel, gallery, atau bagian lain dari halaman web yang 

perlu pemisahan. 

 <p> adalah untuk membuat pargraf. 

 <article> adalah untuk membuat sebuah artikel. 

 <footer> adalah digunakan pada bagian bawah halaman, dimana kita 

menampilkan beberapa informasi mengenai website. 

 rel adalah untuk menunjukkan bahwa file yang dirujuk adalah file 

stylesheet (CSS). 

 type adalah berfungsi sebagai kolom isian dari user. 

 href adalah untuk menentukkan lokasi file (CSS) yang ingin 

disisipkan. 

 id adalah untuk menentukan bagian yang hanya ada satu pada 

halaman dan juga menentukan style nya dan juga tidak bisa dipanggil 

lebih dari satu. 

 class adalah selector yang dapat kita digunakan oleh lebih dari satu 

tag html. Artinya beberapa tag html bisa menggunakan css dari class 

tersebut. Tag class dengan nama yang sama dapat dipakai berulang-

ulang pada satu halaman. 

 src adalah merujuk pada file yang ingin kita masukkan (seperti foto). 

 width adalah untuk mengatur lebar sesuatu secara keseluruhan. 

 height adalah untuk mengatur panjang sesuatu secara keseluruhan. 

 align adalah Untuk mengubah atau mengatur tampilan gambar. align 

bisa diisi dengan beberapa nilai, yakni bottom, left, middle, right dan 
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top. Sesuai dengan namanya, masing-masing nilai dari atribut align 

bisa digunakan untuk mengatur tampilan gambar. 

 alt adalah untuk menentukan teks alternatif yang akan ditampilkan 

saat foto tidak dapat ditampilkan. 

 style adalah digunakan untuk menyisipkan kode style atau CSS ke 

dalam sebuah dokumen web 

 

8. Selanjutnya buat file baru dengan cara “Ctrl+N” pada keyboard atau klik 

menu file dan pilih “New File”. 

 

 

9. Setelah itu, simpan file yang telah dibuat dengan cara “Ctrl+S” pada 

keyboard atau klik menu file dan pilih “Save”. 

1 

2 
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10. Buat folder baru di dalam folder yang telah dibuat sebelumnya, lalu 

simpan di folder yang baru dibuat dan buat nama file dengan type (.css). 

 

1 

2 

1 

2 
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11. Selanjutnya membuat source code dengan menggunakan css. Berikut 

adalah source code untuk membuat style. 

 

1. Membuat nama file 

dengan type .html 

2. Lalu klik save 
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12. Penjelasan : 

 Tanda bintang (*) artinya semua yang berada dalam .html akan 

mengikuti semua elemen yang berada dalam tanda bintang (*). 

 Tanda titik (.) merupakan nama dari sebuah class yang terletak di awal 

nama class. 

 Tanda pagar (#) digunakan untuk memilih semua elemen yang akan 

dipanggil di .html nya menggunakan id (seperti id=portofolio). 

 background digunakan untuk mengatur latar belakang pada sebuah 

website. 

 padding digunakan untuk mengatur spasi atau ruang diantara konten 

dan border. Padding memiliki 4 macam penjabaran yang dapat 

digunakan secara terpisah sendiri-sendiri, yaitu: margin-top , margin-

right , margin-bottom dan margin-left. 

 text-align digunakan untuk posisi teks. 
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 color digunakan untuk mengatur warna teks. 

 text-transform digunakan untuk membuat sebuah teks menjadi besar 

atau kecil semua, atau membuat setiap kata dikapitalisasi. 

 font-size digunakan untuk mengatur ukuran tulisan teks. 

 display digunakan untuk mengatur tampilnya suatu elemen. 

 overflow untuk menentukan suatu konten apakah nantinya konten 

akan ditambahkan scrollbar ketika konten yang terdapat pada elemen 

tidak cukup muat. Terdapat 4 nilai dari properti overflow yaitu : 

visible, hidden, scrool dan auto. 

 backgroud-color digunakan untuk mengatur warna latar belakang. 

 float digunakan untuk mengatur letak element secara horizontal. ada 

empat value yang bisa di gunakan untuk property float, yaitu left, 

right, inherit dan none. 

 list-style digunkan untuk menentukan posisi penanda urutan daftar 

atau list, apakah berada didalam atau diluar urutan daftar tersebut. 

 text-decoration digunakan untuk mengatur efek garis pada suatu kata 

didalam HTML. Pembagiannya ada 3 yaitu underline, line-trough dan 

overline. 

 font-weight digunakan untuk menebalkan tulisan. 

 width digunakan untuk mengatur lebar ukuran element. 

 margin digunakan untuk mengaplikasikan jarak tepi pada sebuah 

elemen bagian luar (tepi garis luar). Margin memiliki 4 macam 

penjabaran yang dapat digunakan secara terpisah sendiri-sendiri, 

yaitu: padding-top , padding-right , padding-bottom dan padding-left. 

 height digunakan untuk mengatur tinggi ukuran element. 

 flex-wrap digunakan untuk menentukan apakah item fleksibel harus 

dibungkus atau tidak. 

 position digunakan untuk menentukan jenis metode pemosisian yang 

digunakan untuk elemen (statis, relative, absolute, dan fixed). 
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 border-radius digunakan untuk menambahkab lengkungan disetiap 

sudut elemen. 

 flex-basis digunakan untuk menentukan panjang awal item fleksibel. 

 flex-grow digunakan untuk mengatur ukuran berdasarkan seberapa 

besar space kosong yang akan diambil. 

 box-shadow digunakan untuk membuat bayangan pada sebuah 

element. 

 transition digunakan untuk efek transisi yang memungkinkan sebuah 

elemen secara bertahap berubah dari satu gaya ke yang lain. 

 transform menerapkan transformasi 2D atau 3D ke elemen. 

 top digunakan untuk menentukan posisi atas dari elemen yang 

diposisikan. 

 left digunakan untuk menentukan posisi atas dari elemen yang 

diposisikan. 

 font-family digunakan untuk menentukan dan merubah jenis tulisan 

yang digunakan pada teks. 

 border-top digunkan untuk mengatur garis pada bagian atas. 

 flex digunakan untuk mengaturan layout, posisi dan tampilan dari 

suatu konten yang ukurannya belum diketahui atau bernilai dinamis. 

 border merupakan garis yang ada pada objek sehingga bisa menjadi 

pembatas satu objek dengan objek lainnya. 

 letter-spacing digunkan untuk mengatur jarak antara karakter / untuk 

mengatur jarak antara teks didalam sebuah halaman website. 

 max-width digunakan untuk mengatur lebar maksimum sebuah 

elemen. 
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13. Selanjutnya buat folder baru didalam folder yang telah dibuat diawal, 

untuk meletakkan gambar yang digunakan untuk design website. 
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B. Hasil dan Pembahasan 

 

 



 

263 

 

 

 

 

 

Pada gambar di atas adalah membuat Design Web dengan tema E-

Commerce menggunakan aplikasi Sublime Text, sehingga membuat Design 

Web berhasil di lakukan, karena saya mengikuti pedoman yang saya 

lihat/dapatkan. 
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